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Introduction
What will you learn?
In this tutorial, you’ll learn how to create a photographic portrait in Daz Studio. You’ll do many of the
things that a photographer would do when shooting a portrait:
Set up a studio.
Choose and style a subject.
Pose the subject.
Add ambient light.
Apply a key light, fill light and rim light.

What should you already know?
The tutorial assumes that you have installed Daz Studio and have a basic familiarity with it. If you’re
new to Daz Studio, it would be a good idea to work through Daz’s QuickStart Guide before proceeding:
1. Run Daz Studio.
2. From the Help menu select QuickStart Guide….0.
This will open your web browser and display Daz’s introductory tutorial.

About this document
Your feedback and suggestions regarding this tutorial will always be appreciated.
The document was developed using Daz Studio version 4.8, but the techniques should be easily
applied to other versions.

Cheers,
Tim N.
Perth, Western Australia
TimFromPerth@gmail.com
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1. Creating a photography studio in Daz
Creating a studio with primitives
Portraits are often shot in a photographic studio. Creating a studio environment in Daz is simple. You
create a floor for the subject to pose on and a single wall behind the subject to act as a background:
1. Run Daz Studio. If it’s already running, from the File menu select New…. This will create a new,
empty scene.
2. From the Create menu, select New Primitive…. This will display a dialog box.
Set Type to Plane.
Set Size to 10.
Set the units popup menu (next to the Size field) to m
for metres.
Press Accept.
This creates a floor surface that you can stand your subject
on.
A good practice in Daz is to name each object as you add it
to the scene, so:
3. In the Scene pane, select the newly created object. It will be called ‘plane’. (If you don’t see the
Scene pane, from the Window menu select Panes (Tabs) then Scene.)
4. Click on it again and a cursor will appear. Press Backspace on your keyboard and type in the
name ‘Floor’. Press Enter.
Now that you have a floor, add a wall using a
similar series of steps:
5. From the Create menu, select New Primitive….
6. Press Accept to accept the same settings as
above.
This creates another plane that is the same size as
the floor. You can’t see it, though, because it’s
overlapping the floor. You’ll fix that by standing it
on its side so that it becomes a wall.
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7. In the Scene pane, select the newly created
object. (It will be called ‘plane 2’.)
8. Rename it to ‘Wall’ using the steps above.
9. In the Parameters pane, set the X Rotate value
to 90. (If you don’t see the Parameters pane,
from the Window menu select Panes (Tabs)
then Parameters.)
If you zoom out, you’ll see that the wall is
upright but is in the middle of the floor.
Now you’ll push the wall back towards the rear
edge of the floor. This will give you more space
in your studio:
10. In the Scene pane, select the Wall object.
11. In the Parameters pane, set the Z Translate value to
–500.0.
This pushes the wall back by 500 cm (5 metres).

Applying shaders to the floor and wall
Neither the floor nor the wall looks very convincing. At present
they just look like bland, grey planes. Fortunately, Daz Studio
supports shaders. A shader is a small program that draws a
repeating pattern upon a surface. For example, you could have
shaders that make a surface look like wood, stone or grass.
You can view the shaders available to you like so:
1. In the Content Library pane, open the Daz Studio Formats
item. (If you don’t see the Content Library pane, from the
Window menu select Panes (Tabs) then Content Library.)
2. Open the My Library item. (This may have another name.)
3. Open the Shader Presets item.
This will reveal a collection of shaders organised into
folders.
Your Content Library pane will be different to the one shown
here. Don’t be concerned.
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When you first download Daz Studio, it doesn’t provide many shaders. Fortunately, you can buy a
wide variety of shaders from the Daz Store:
www.daz3d.com

The Daz Store home page.

www.daz3d.com/shaders

The shaders section of the Daz Store.

If you don’t yet have any suitable shaders to apply to the floor or wall, skip ahead to the next chapter of
this tutorial. You can apply the shaders later, and the remainder of the tutorial will be unaffected.0.
Now let’s apply a shader to the floor:
1. From the Tools
menu, select the
Surface Selection
tool.
2. Click on the floor
object in the
Viewport (the
main window).
3. In the Content
Library pane find
the shader that
you wish to apply
and double click
on its icon.
In this example, I’ve
used a shader
product from the Daz Store called ‘Design ToolBox’. I’ve applied the shader named ‘Maple Boards
01’. There is nothing special about this particular shader, so feel free to complete the tutorial using
the shader of your choice.
Using a similar series of steps, apply a shader to your wall surface:
4. From the Tools menu, select the Surface Selection tool.
5. Click on the Wall object in the Viewport.
6. In the Content Library pane find the shader that you wish to apply and double click on its icon.0.
In this example, I’ve applied a shader named ‘Slate 05’.
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Clearly this is a great improvement.
There are a couple of problems, though with the
particular shaders shown here that you may (or
may not) be experiencing with your own choice of
shaders.
The first is that the slate tiles on the wall are far too
large. Fortunately, this isn’t really a problem
because the Viewport pane is only showing a
preview of your image. When you render your
image, the slate tiles will be a more reasonable size.
(See the image below.)
The other problem is that the slate tiles have been
applied vertically, rather than horizontally. (That is,
they’re taller than they are wide.)
Of course, if you’ve chosen a different shader you
may not have this problem now. You may experience something similar with other shaders in future,
though, so it’s worth understanding how to fix the problem.
Skip the following two steps if you’re using different shaders to those shown here.
Fortunately, fixing this problem is easy: you just rotate the wall by 90 degrees:
1. In the Scene pane, select the Wall object.
2. In the Parameters pane, set the Z Rotate value
to 90.0.
This rotates the wall so that the tiles are in a
more pleasing orientation.
Here’s a render of the room so far:
Your image will look different to this, of course, if
you’ve used different shaders.
The beauty of shaders is that they can turn two
planes into a room with very little effort.
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Rendering your image
Prior to version 4.8 of Daz Studio, renders were almost always done using the 3Delight rendering
software that’s built into Daz. Version 4.8 introduced a second renderer call NVIDIA Iray.
It’s worth noting that some shaders available in the Daz Store may work well with both renderers,
others with only one.
As 3Delight is the more established choice, that’s the renderer used to create the images in this
tutorial, but feel free to experiment with both. (If you’re not sure which to use, you’ll probably find the
3Delight renderer to be the simpler choice.)
You can choose which renderer you wish to use like so:
1. In the Render Settings
pane from the Engine
popup menu select
3Delight or NVIDIA Iray.
If you don’t see the Render
Settings pane, from the
Window menu select
Panes (Tabs) then Render
Settings.0.
To perform the render:
1. Enter the desired size for
your render into the W
(width) and H (height)
fields.
2. Click on the Render button
at the top-right of the
Render Settings pane, or
select Render from the
Render menu.0.
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2. Adding the subject character
Having created a simple photography studio, your next task
is to add, style and pose your subject.
You can add a figure to your scene using the Smart Content
pane or the Content Library pane. This tutorial will use the
former as many new users find it simpler. Feel free, though,
to use either.
1. In the Smart Content pane, select the Figures category.
(If you don’t see the Smart Content pane, from the
Window menu select Panes (Tabs) then Smart
Content.)
2. Right-click on the figure that you wish to use, and select
Merge into Scene.
3. In the Smart Content pane, select the Wardrobe
category.
4. Right-click on the clothing items that you wish to use then select Merge into Scene. Do this for as
many items as you wish.0.
In the example shown here, I’ve used the figure ‘Genesis 2 Base Male’ and added the clothing items
‘Newport Shirt’ and ‘Newport Pants’. Your scene will look different to this, of course, if you make
different choices. That’s fine.
Feel free to add hair to your figure. Keep in mind, though, that hair (particularly long hair) increases
render times.
You now need to pose your character:
1. In the Scene pane, select the figure. (‘Genesis 2 Male’ in my
case.)
2. In the Smart Content pane, select the Poses category.
3. Right-click on your preferred pose then choose Merge
into Scene. This will apply the pose.0.
In this example, I’ve applied the pose ‘Base 18’.
Of course, you can pose the figure manually if you prefer.
Alternatively, you can start with a supplied pose like this
one then make your own adjustments to it.
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3. Adding ambient light
Daz Studio’s default light
You may think that your scene doesn’t currently have any lights in it. After all, the Scene pane only has
three objects in it: Floor, Wall and Genesis 2 Male.
Actually the Scene does have a light. It just isn’t shown in the Scene pane. When you first create a
scene (File > New), Daz creates a simple light that is positioned at the same point as the camera and
pointing in the same direction as the camera. As you move the camera, the default light moves with it,
so that the scene is always evenly lit. The default light is why your existing renders have not simply
been black scenes.
As soon as you add any other light to your scene, the default light is removed. If you remove all of your
lights, the default light reappears.
If the default light exists and is so effortless to use, you might wonder why you should bother adding
other lights. Well, the default light is very basic. For example, it doesn’t cast a shadow, and you have
no way to alter its colour or intensity. Adding your own lighting manually will make your renders
substantially better.

Lighting like a photographer
Lighting your scene can be a complicated and frustrating business if you just randomly add lights
without knowing what you’re doing. A good discipline is to mimic the lighting that a real scene would
have.
In this tutorial, you’re going to add four lights:
The ambient light will provide low but even light across the entire scene.
The key light will be the main light drawing attention to your subject.
The fill light will be used to prevent any part of the figure from being too much in shadow.
The rim light will add a halo around your figure.

Adding ambient light with UberEnvironment2
As noted above, an ambient light is used to provide low but even lighting across the entire scene. In
Daz Studio, this is best accomplished using the UberEnvironment2 light. You can add it to your scene
like so:
1. In the Content Library pane, open the Daz Studio Formats item.
2. Open the My Library item. (This may have another name.)
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3. Open the Light Presets item.
4. Open the omnifreaker item and select UberEnvironment2.
5. Right-click on the icon !UberEnvironment2 Base and select Merge into Scene.0.

If you render your scene you’ll see that it’s
substantially better lit than it was before.
You may find the image to be a little grainy or
noisy. That’s to be expected. You’ll soon fix
this by altering a quality setting.
The UberEnvironment2 light has provided an
even light across the entire scene.
As good as this is, the UberEnvironment2 light
isn’t designed to be the only light in your
scene. It works best when supplemented by
other lights such as a key light and a fill light.
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Adding an environment map
Before adding more lights, though, let’s alter a few of the settings of your UberEnvironment2 light:
1. In the Scene pane select UberEnvironment2 1.
2. In the Content Library pane right-click on Set HDR Studio and select Load.
Nothing will have happened to your preview image in the Viewport. If you render your image,
though, you’ll see that it has a strong orange tint to it. What’s happened here?
The UberEnvironment2 folder contains eight environment maps. These are images that alter the
ambient light’s colour and intensity based on
direction. They are:
Set HDR Candlelight
Set HDR CornellBox
Set HDR Dawn
Set HDR FullMoon
Set HDR KHPark
Set HDR Kitchen
Set HDR SoftBox
Set HDR Studio
3. Right-click on the first of these environment
maps then select Load. Now render your
image.
4. Repeat the previous step for each
environment map. Which ones do you like?
The images shown here use the CornellBox and
KHPark shaders.
If you wish to remove the environment map
and do without one, the easiest strategy is to
delete the UberEnvironment2 object from the
scene and insert a new one.
Your rendered image changes greatly
depending upon which environment map you
apply. Environment maps are an easy way to
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achieve sophisticated lighting with a few clicks.
Before proceeding, apply the CornellBox environment map to follow along with the tutorial:
5. Right-click on Set HDR CornellBox and select Load.0.

Quality settings
The UberEnvironment2 folder also contains five quality settings. These affect the grain or noise that
appears in your rendered image. They are:
Set Quality 0XLo
Set Quality 1Lo
Set Quality 2Med
Set Quality 3Hi
Set Quality 4XHi
As you might expect, higher quality settings take longer to render. You can change the quality setting
like so:
1. In the Scene pane select UberEnvironment2 1.
2. Right-click on the first of the quality settings, and select Load. Now render your image.
3. Repeat the previous step for each quality setting. How long did each render take?0.

The UberEnvironment2 Environment Sphere
1. In the Scene pane select UberEnvironment2 1.
2. In the Parameters pane set Scale to 2%.
This will reveal a small sphere, called the
Environment Sphere, at the feet of your figure in
the Viewport.
3. In the Parameters pane set X Translate to 50 and Y
Translate to 20 to move the sphere to one side and
up a little.
Environment maps often have a bright side and a
dark side. By rotating the environment sphere you
can change the direction from which the light
strikes your subject.
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The CornellBox environment map shown here has a lighter
blue side and a darker red side. If you rotate it, your
rendered image will look quite different:
4. In the Parameters pane set Y Rotate to
–90.
The environment sphere now has its lighter blue side
lighting the left of your figure. The darker red side is lighting
the other side.
When you render the image, you’ll see that the left of the
figure’s face is thus lighter.0.
This image is pleasantly moody but too dark. Remember,
though, that you rarely use an UberEnvironment2 light by itself.
You’ll soon add a key light and fill light to brighten up your
subject.
Before proceeding, let’s replace the CornellBox environment
map with the brighter KHPark map:
1. In the Scene pane select UberEnvironment2 1.
2. In the Content Library pane right-click on Set HDR KHPark
and select Load.
The KHPark environment map is commonly used in Daz
renders. One side of this image has a very bright spot
simulating sunlight. By rotating the image you can control
the direction of the light in your render.
3. In the Parameters pane set Y Rotate to –90.
The environment sphere now has the bright spot on the left.
When you render the image, you’ll see that the left side of
your figure’s face is brighter.
Also the shadow cast on the floor is now coming from the
left.0.
As noted earlier, environment maps are an easy way to achieve
sophisticated lighting with a few clicks.
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The UberEnvironment2 Environment Mode
The UberEnvironment2 light has an important setting called the Environment Mode. It can be set as
follows:
1. In the Scene pane select UberEnvironment2 1.
2. In left-hand side of the Parameters pane select the Light item.0.
In the right-hand side of the pane is a popup menu labelled Environment Mode. It has six values,
three of which are commonly used. Their effects on the render are shown here:

Ambient (No Ray Tracing)

Occlusion w/Directional Shadows
(the default)

Indirect Lighting
w/Directional Shadows

Ambient (No Ray Tracing): No shadows will be cast by the objects in your scene. (Look at the
floor in the leftmost image above.) This is a less realistic type of light, but the scene will render
quickly.
Occlusion with Directional Shadows: Shadows will be cast. Furthermore, by rotating the bright
spot on the environment map you can change their direction. This is the default environment
mode.
Indirect Lighting with Directional Shadows: In addition to movable shadows, the light will also
bounce off nearby surfaces causing light to hit your subject from more directions. This provides
brighter and more realistic lighting but renders more slowly.
In the example images above, there seems to be little difference between the latter two images.
Complex scenes will often yield significantly better images, though, when you choose indirect
lighting.

UberEnvironment2 Intensity
The Intensity setting can be used to alter the overall amount of light contributed to your scene by the
UberEnvironment2 light. You’ll adjust this later after you’ve added another light to your scene.
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4. Adding a key light
Off-camera lighting
Photographers shooting a portrait rarely
use the flash built into their cameras.
Rather, they use off-camera lighting.
That is, they have one, two, three — or
even more — lights mounted on light
stands and placed around the studio.
This chapter will begin the process of
adding such lights to your scene.
Before you continue, though, use the
illustration at right to familiarise yourself
with the names of a few objects in the
Daz user interface as they’ll be used in
the instructions that follow.

Adding a key light
The main light illuminating your subject is called the key light. Daz Studio provides a light called the
Spotlight that is well suited to acting as a key light. Let’s
add one to our scene:
1. From the Create menu select New Spotlight….
2. In the name field enter ‘Key Light’.
Remember: it’s a good idea to name all the objects in
your scene as you go.
3. Select the option Apply Default Settings, and press
Accept.
A new spotlight object will appear in your Scene pane
and in your Viewport.
4. From the Window menu select Viewports then Side by Side.
This will divide your viewport into two halves, each of which can be looking at a different part of
your scene.
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5. Click on the View Popup control
on the right-hand pane of your
Viewport, and choose Key Light
from the popup menu that
appears.
The left-hand pane continues to
display the view through the
Perspective Camera. This shows
how your scene will look when
it’s rendered.
The right-hand pane of your
viewport now displays what the
key light is pointing at.
At present it’s probably pointing
at the wall. Let’s make it point to
your figure:
6. Select your figure (Genesis 2
Male) in the Scene pane.
7. In the right-hand pane of your
Viewport, click on the Reset then
the Frame controls.0.
The right-hand pane should now
be looking directly at your figure.
In other words, the key light is
pointed directly towards (and
illuminating) the front of your
figure.
If you now render your figure, you
may see an error message like this
one. If so:
1. Click on OK.
2. Click anywhere in the left-hand pane of your
viewport.0.
You should now be able to start a render without any problems..
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Positioning the key light
Adding a key light has greatly improved your image.
It’s certainly much brighter than it was with only the
ambient light provided by UberEnvironment2.
It does have an obvious problem, though. See that
big splash of light on the back wall? It’s kind of
distracting.
Portrait photographers will often place the key light
to one side of the figure, rather than directly in front.
The key light is also often also placed high and
looking downwards.
1. In the Scene pane, select the Key Light.
2. Use the Camera Cube, Pan, Zoom and Orbit
controls in the right-hand pane of your Viewport
to place the key
light a little to the
left of the
character,
positioned high
and aimed
downwards.0.
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Render the image now, and you’ll see that you’ve
eliminated the bright splash of light on the back
wall.
You’ve also created a nice shadowing on the
figure’s face. Notice how the left-hand side is
bright and the right-hand side is in shadow.
Photographers appreciate an effect like this,
enthusiastically using words like contrast and
drama to describe it.
You may feel that the right-hand side of the face is
too dark, though. That’s why the next chapter will
add a fill light — a weaker light aimed at the other
side of the figure.

Adding shadow
Before we do that, though, we’re going to fix a
glaring mistake. The key light that we just added
isn’t casting a shadow.
There is a soft shadow on the floor, but that’s
being provided by the UberEnvironment2 light. (If
you turn off the Key Light in the Scene pane, that
shadow will remain.)
We have two lights in our scene now (ambient and
key), so we should expect two sources of shadow:
1. From the Scene pane, select the Key Light.
2. In the left-hand side of the Parameters pane,
select the Shadow item.
3. In the right-hand side of the Parameters pane
change the Shadow Type popup to Raytraced (Software Only).
Now render your scene and you’ll see a new shadow on the floor. (Your choice of floor shader may
affect how prominent this shadow appears.)
At this point you may wish to rotate the environment sphere of the UberEnvironment2 light so that
the two shadows overlap. Alternatively, you can rotate your key light.
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This new shadow is realistic, but you may find it a little distracting. There are two easy things we can
do to change this. One is to adjust the intensity of the shadow like so:
4. In the right-hand side of the Parameters pane change the Shadow Intensity to 50%.
The shadow is now less prominent.
The other thing you can do to make the shadow less distracting is to zoom and rotate the camera so
that less of the floor is visible. Photographers call
this framing your subject.
5. Use the Camera Cube, Pan, Zoom and Orbit
controls in the left-hand pane of your
Viewport to position the camera so that less
of the floor is visible.
Remember that you do this in the left-hand
pane of the Viewport as this is where you have
your camera view. (The right-hand side is the
view from your key light.)0.
Now that we’ve got a closer look at our figure, it
seems that there’s too much light hitting the lefthand side of his face. That bright hot spot near the
ear is something to be avoided.

Balancing light levels
A good first step to balancing our light levels is usually to reduce the intensity of the
UberEnvironment2 light:
1. In the Scene pane select UberEnvironment2
1.
2. In left-hand side of the Parameters pane
select the Light item.
3. In right-hand side of the Parameters pane set
the Intensity to 50%.0.
This has reduced the excessive light level and our
render is coming along nicely.
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5. Adding a fill light
Positioning the fill light
A fill light is a weaker light designed to remove overly harsh shadows that may have been created by
the key light. You may have one or two fill lights or none. It’s very much a matter of personal taste.
A common strategy, though, is to place a fill light like so:
Place it on the opposite side of the figure to the key light.
Place it at around half the height and angled a little upwards.
Set the intensity at around one-third to one-half of that of the key light.

Adding the fill light
Let’s add one to our scene:
1. From the Create menu select New Spotlight….
2. In the name field enter ‘Fill Light’.
3. Select the option Apply Default Settings, and press Accept.
A second spotlight object will appear in your Scene pane and will also appear in your Viewport.
Now let’s position it as described above:
4. Click on the View
Popup control on the
right-hand pane of your
Viewport and choose
Fill Light.
The right-hand pane of
your viewport now
displays what the fill
light is pointing at. Let’s
make it point to your
figure:
5. Select your figure
(Genesis 2 Male) in the
Scene pane.
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6. In the right-hand pane of your Viewport, click on the Reset then the Frame controls.
The key light is now pointed directly towards (and illuminating) the front of your figure.
7. In the Scene pane, select the Fill Light.
8. Use the Camera Cube, Pan, Zoom and Orbit
controls to place the fill light to the right of the
figure, around waist height and aimed a little
upwards.0.

Balancing light levels
Now let’s lower the intensity of the fill light:
1. In the Scene pane select Fill Light.
2. In left-hand side of the Parameters pane select
the Light item.
3. In the right-hand side of the Parameters pane
set Intensity to 35%.
Render the image now, and you’ll see that you’ve
lessened the shadow on the right-hand side of the
image.
There’s still a pleasing contrast, though, between the
lightness of the two halves of the face.
The final image here is unchanged except that the
KHPark environment map has been replaced with
the CornellBox environment map.
You might find the darker, moodier lighting
preferable.
Positioning lights well and setting their relative
intensities pleasingly will require some experience.
Daz Studio allows you to gain this through pleasant
hours spent just ‘playing around’.
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6. Where to from here?
Rim lights
Portrait photographers will often put a light in the scene that is positioned behind and to the side of
the subject. This is called a rim light, back light or kicker and is designed to provide a halo of light
around the edge of the subject. (It can be particularly effective at illuminating hair.)

The Viewport shows the Rim
Light positioned behind the
figure.

With the other lights turned off in the
Scene panel, the Rim Light (Intensity =
150%) provides an obvious halo of
light.

With all of the lights turned back on,
the Rim Light adds a touch of
sophistication.

Add other objects to the scene
The Daz Studio store provides lots of objects
that you can add to your scene if you wish to
make it more complex.
Enjoy letting your imagination loose!

Cheers,
Tim N.
TimFromPerth@gmail.com

Where’s my watch?
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